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Welcome to Keymap One 1.5

This addendum describes features introduced with the version 1.5 which 
are not covered in the Keymap One user’s guide. The descriptions in this 
addendum supersede the information described in the user’s guide.

Keymap One 1.5 features overview
Integration with Logic 8
Keymap One integrates with Logic 8 so that you can use it as an additional editor for your EXS24 
instruments from within the Logic 8 environment without having to load/save files and refresh menus. 
With this feature, the combination of Logic and Keymap One offers the most sophisticated sampling 
environment ever.

Drag and Drop support for Zones and Groups from the Logic 8 internal 
EXS24 editor
You can drag and drop zones and groups from the new internal EXS24 editor in Logic 8 to Keymap One. 
This is also useful for bringing audio regions from the Logic arrange view to Keymap One.

Virtual MIDI input to Keymap One
Keymap One now includes a virtual MIDI input. This makes it possible to drive Keymap One from a 
sequencer, and hear the sampler instruments in the context of a song while you are editing them. 
Keymap One can now also play when in the background, and offers a virtual MIDI thru connection with 
extended configurability in order to offer the most flexing integration in your workflow.

MIDI and Audio Smart Switches
In order to provide the most flexible Keymap One integration to your Audio/MIDI setup, there are now 
four automatic switches (called Smart Switches) that govern the flow of MIDI events between the various 
Keymap One MIDI ports, as well as  control the Keymap One audio outs. These switches can be configured 
via the preferences to automatically turn on or off depending on the status of the application (active, in 
background, etc), so that you can have Keymap One perform exactly in the way you want it to.
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Support for GarageBand, Ultrabeat formats
Keymap One now loads and saves instruments also in GarageBand format, and Ultrabeat sample format 
(.ubs).

Support for EXS24-Monolithic format
Keymap One now loads and saves instruments in a special EXS24-Monolithic format,  in which all the 
samples are stored inside the .exs instrument file.

Keymap One Organizer
A new window lets you switch between projects, and select which one should respond to the incoming 
MIDI stream.

Drag and drop sample export from Keymap One
You can now drag and drop edited samples from the instrument editor or the resources window 
directly to the finder.

Tuning Fork
Keymap One now offers a pure sine wave generator that gives you both acoustic and visual feedback for 
your tuning settings.

Extended contextual menus
All the contextual menus have been revised and expanded

Expanded Resources window with integrated Sample and Loop editors
The resources window now  offer fully resizable integrated sample and loop editors, so that you can 
perform many tasks while remaining in one single window.

“In context” sample replace 
The new “in context” sample replace function means that when you replace a sample, you can keep 
playing the instrument from MIDI and preview the selected sample from the open panel directly in the 
context of  the instrument (with volume, pan, tuning, looping, etc) before actually replacing it.
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Remap by note and velocity
A new function lets you remap multiple zones over notes and velocity, in a single go. 

New group creation commands
New group creation commands allow you to assign a new group to a set of selected zones, create and 
assign individual groups for each selected zone, or create and assign a group to a whole layer.

Key commands reorganization
The key commands have been reorganized and streamlined. All functions are now available also as key 
commands, and the key commands are global  so that you can, for example, use zone key commands also 
while editing a sample. All menus, including the contextual menus, show the equivalent key commands.

Add/subtract one sample from loop end command
Two new commands let you add or subtract one sample from the loop end, which can help you  fix 
instruments converted from other formats.

Additional functions for the Magic Pad
The Magic Pad functions have been extended through the use of key modifiers, and multiple samples can 
now be dropped to create multi-velocity mappings and more.

Drag and drop support to single note, multiple velocities
Similarly to what is now available for the Magic Pad , the matrix now also allows dropping multiple 
samples to a single note, in order to create a multi-velocity mapping.

SD2 Read sample support 
Keymap One now supports the SD2 sample format.

New Zone swap along velocity commands
Two new functions let you swap zones along the velocity axis in the instrument matrix, making it easier to 
sort samples by velocity manually.
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Zoom freeze
In the sample editors it is now possible to freeze (render to disk) the horizontal zoom and relative position 
from the sample start. This makes it easy to inspect the same portion of a sample across multiple samples.

Sliders reset
Sliders can now be reset to their default values by holding the alt key modifier while double clicking on 
them.

Extended support for analyzing root notes in sample names
The support for analyzing and reading root note names embedded in sample names has been improved.

New close project command
A new command lets you close the entire project in one single go.

Tooltips disable
You can now disable tooltips.

Default PreStart and PostEnd space when splitting samples
When cutting sample regions, you can now add a default extra space (in other words, an amount of 
silence) automatically to the beginning and/or to the end of the region, so you have some room to tweak 
your samples (attack, etc) after the split.

Drag and drop zone copy in matrix
You can now copy zones simply by dragging them in the instrument matrix while holding a key modifier.

Automatic playback restart when browsing zones and regions
When you browse zones or sample regions and you have playback active, Keymap One will 
automatically restart playback so that you can listen to the samples simply by  moving the cursor 
keys.
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Sort zones by name
A new function lets you sort zones (over the velocity or over the note ranges) by name in both ascending 
or descending order, so that if you want to remap zones in the matrix, you can simply assign the proper 
names/numbers, and sort them.

New “Select all zones in current note range” command
This command selects every zone within the current note range.

Commands improved to handle multiple zones at once
Even more zone commands have been extended to support multiple zones at once.

Reset sample start/end command
This convenient new command lets you set the start and the end of your zone to the start/end of the 
sample.

Improved editing of samples with blended cuts
When cutting/deleting/pasting samples, Keymap One can automatically set a desired crossfade 
length and shape in order to smooth the edit. You can see the crossfade by enabling slice view in 
the Sample Editor. A new Blend menu command let you add/change a crossfade to a split.  This 
crossfade has an arbitrary length crossfade and can be multiple shapes.

Extended selection modes from MIDI/Virtual keyboard
Keymap One now offers three distinct selection modes in its instrument editors, which lets you set 
how Keymap One reacts to incoming notes from either your active MIDI Ports or from the Virtual 
Keyboard. The incoming MIDI notes can select the currently playing zone in the current layer, select 
the currently played zone(s) in all the layers, toggle the selection, or be ignored.

Group assign in resources window
It is now possible to assign a group to zones directly from the resources window.

Gray out already used samples in open panels
When adding/replacing/searching samples you can now gray out samples already used in your project.

MIDI Input preprocessing
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A new preference setting lets you pre-process incoming MIDI notes in order to replace the velocity with 
the current value of a MIDI controller. This is useful  for precise editing  using a MIDI controller such as a 
knob or pedal instead of using the actual velocity.

MIDI Controllers learn
All pop-up menus that let you select a MIDI controller have a MIDI learn feature now.

Instrument and layer name visualization in matrix
The currently selected layer is now displayed in the matrix. Similarly , the currently selected instrument is 
displayed in the setup matrix, together with any transpose or velocity offset you might have set.

Improved sequential mapping in matrix
When sequentially mapping samples in the instrument matrix you can now set a starting note and the 
width of each created note.

Group range visualization in matrix
It is now possible to graphically visualize the range of groups in the zone matrix superimposed with the 
zones, which offers you a clear graphic display of the zones/groups relationships.

Dynamic crossfade controller visualization in matrix
When using a dynamic crossfade MIDI controller instead of velocity  (example: the modulation wheel), it is 
now possible to visualize in realtime the controller value directly in the matrix. This allows for very simple 
and intuitive editing.

Dynamically switchable editor layouts
It is now possible to switch across the various layouts (compact, normal, wide) for the instrument and 
setup editors at any time.

Optional selection sync between instrument editor and resources 
window
You now have the option to synchronize the selection between the instrument editor and the resources 
window, so that it’s easier to jump between the two windows.
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Region selection keycommands
Two new menu commands (and key commands) let you select the next or previous sample region.
e files.

Key commands export now embeds font
When exporting key commands, the clipboard now also contains font specification so that when you 
paste the text, it’s already formatted correctly.

Extended key commands and key navigation system

Improved layer support for EXS format
Keymap One layers are now saved in a more robust way in EXS format instruments.

Increment/decrement controls for most parameters
Most of the parameter boxes in Keymap One now supports incrementing or decrementing the value 
using the up/down cursor keys, and mouse dragging. You can now select a parameter, hold down the 
alternate key modifier and drag the mouse to set the desired value. A double click while holding the alt 
key resets the parameter to its default value. 

Zone toggle loop function
A new command lets you enable/disable the loop function for multiple zones.

Pivot remapping functions
You can now pivot the selected zone over the note and velocity axis so that a multiple note mapping 
becomes a multi velocity mapping and vice-versa. The operation can also be performed for complete 
layers.

Search for missing samples function
You can now search for missing samples in your projects at any time, not just load time. This gives you the 
opportunity to update your LiveDB sample search paths, and search again for samples using the new 
search paths without having to reload the instrument.
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New set from cursor functions in sample editor
New commands let you set various sample position cursor (start, end, loop, etc), to the current sample 
cursor position.

Reorganized preferences panel with default values
The preferences panel now enables you to set the default values for certain parameters when creating 
new projects.

New intersect all groups to all zones command
You can now intersect all zone ranges (notes, velocity) with their groups in order to streamline your 
projects. This is a useful way to get much better zones/layer layouts with instruments converted from 
other formats in which the zones take the whole velocity range, but the group limits that range to a very 
small section. .

Redesigned layout functions
The various editor windows sizes, positions, zoom levels, etc, are now saved globally, not just for each 
project. This means that once you find a comfortable layout on your screen, all projects will open with 
that layout.

Relink to Renamed Samples (RRS)
The LiveDB sample search engine in Keymap One can now also search and relink samples that have been 
renamed outside of Keymap One, either manually or by using 3rd party utilities.

New sample Slice cursors
The full Sample Editor now shows 3 new cursors for each slice, allowing you to move the slice point and 
shift the slice content.

… and many other improvements.
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Integration with Logic 8
You can now use Keymap One 1.5 as an additional editor for your EXS24 instruments from within Logic 8 
without having to load/save files and refresh instrument menus. With this feature, the combination of 
Logic and Keymap One offers a very sophisticated sampling environment.

How it works
In Logic 8, there's a new Open in external editor entry in the EXS24 Options menu. The very first time you 
use this menu you will be asked which editor you would like to use;set this to the Keymap One 1.5  
application.  After you perform this setup, the menu entry reads Open in Keymap One.  At this point you 
can send instruments loaded into an instance of EXS24 to Keymap One at any time simply using the Open 
in Keymap One menu command.

Logic/EXS24 Keymap

You send an EXS instrument to Keymap by 
using the Open in Keymap menu 

command in the EXS24 option menu.

Once the instrument is sent to Keymap One, you can edit it using the full Keymap One arsenal of tools, 
while the EXS24 still keeps playing the original copy in Logic. Every time you want to update Logic and 
the EXS24 with the edited instrument from Keymap One, use the Send back to Logic menu command in 
Keymap One , or press the ➡EXS24 button which appears in all Keymap One editor windows.
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Logic/EXS24 Keymap

You send the instrument back to Logic/EXS24 
by clicking the "➡EXS24" button or using the 
File>Send back to Logic menu command in 

Keymap.

The EXS24 synchronizes its instrument with the one from Keymap One, and you can continue editing in 
Keymap One, or use the internal EXS editor to further tweak the instrument. At any time you can 
synchronize the Keymap One instrument with the one from EXS24 by using the Open in Keymap One 
menu command (which you can actually think of as Send to Keymap One) for the desired instrument. 

You do not actually need to continuously send the instrument back and  forth between the EXS24 and 
Keymap One.  You can send the instrument to Keymap One just once, and then send it back to the EXS24 
every time you want to synchronize it with the Keymap One edits.

At all times Logic keeps playing a local copy of the instrument inside the EXS24, so it's up to the user to 
ping-pong between the EXS24 (including its new integrated mapping editor) and Keymap One by 
sending updates from one side to the other. This system lets you combine the editing capabilities of the 
EXS24, the new EXS24 internal editor and Keymap One.

Another important thing to keep in mind is that all instrument transfers from Logic to Keymap One (Open 
in Keymap One ) are initiated by Logic. Keymap One can't “request” an instrument.  Similarly, instrument 
transfers from Keymap One to  Logic (Send back to Logic) are initiated by Keymap One, as Logic also can't 
request an instrument from Keymap One.



The Keymap One ↔ EXS24 Editing Session
The link between Logic and Keymap One keeps going for as long as both applications are open.  This is 
defined as an “editing session”.  If you close Logic while a Logic-originated instrument is open in Keymap 
One, you will stop the editing session and lose the capability to send it back. Similarly, if you close Keymap 
One without sending the instrument back to Logic first, you will lose all edits you made for that 
instrument in Keymap One.

Both the EXS24 and Keymap One can handle and manage several different instruments at once. You do 
not need to do anything special about this: if you send an instrument named  “DrumKit1” from EXS24 to 
Keymap One, you can send it back anytime during the course of that editing session, with no need for the 
EXS24 plugin to be open for that specific instrument, or for a specific Logic track to be selected. 

Differences
A good way to view this integration is to think of Keymap One as an additional editor for your Logic-
originated instruments. While nothing changes if you use Keymap One with instruments opened from 
within Keymap One’s own  Open menu command, a few things in Keymap One actually do change in 
behavior when you edit instruments received (originated) from Logic 8/EXS24.  These are the main 
differences:

No save allowed from Keymap One, Save menu becomes Send back to Logic
All instruments in Keymap One that were received from Logic/EXS24 in an editing session using the 
integration mechanism can only be saved to disk by Logic/EXS24. For this reason, when editing a Logic-
originated instruments the Save menu becomes Send back to Logic, and you have to send back the 
instrument from Keymap One to the EXS24, then save it in the EXS24.

Keymap  does not load or save instruments 
directly, when they originate from Logic 

EXS24 Keymap
EXS24 

Internal 
editor
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Save As… becomes Convert to Keymap One project
The Save As… menu command is not available, and there is a new Convert to Keymap One project 
menu command instead.  With this command you can convert an instrument originally sent from Logic/
EXS24 to a full Keymap One project.  Once an instrument is a Keymap One project, you can then save it 
wherever you want  from Keymap One, as the Save menus will become available again. Note that this 
command breaks the link between the EXS24 and Keymap One for that specific instrument; if you send it 
again from Logic to Keymap One, Keymap One will open a new instance.

EXS24 Samples for Logic-originated instruments can’t be moved
The Move samples command is disabled in Keymap One for instruments received from the Logic side. 
You can however still add new samples to instruments and remove zones (and samples) from the 
instrument.

“Open recent” not active
Since instruments originated from Logic/EXS24 are not technically Keymap One documents, they are not 
listed in the Open Recent menu in Keymap One.

How to register a specific version of Keymap One as external EXS editor 
in Logic

At any time, you can reassign the Open in Keymap One menu to a different Keymap One application than 
the current one (possibly a different version), by holding down the option key and opening the Options 
menu in the EXS24. The Open in Keymap One menu entry will be shown as Choose external Instrument 
editor, and it will let you choose a new/different Keymap One application.

An alternative and simpler way to register Keymap One with Logic, is by using the Utilities>Register 
Keymap One as EXS24 editor in Logic menu command in Keymap One, but this can’t be done while 
Logic is running.

It’s very important to remember that if you move the Keymap One application after registering it with 
Logic, you will have to register it again as the path to the application has changed and Logic might not 
find Keymap One at the previously registered location on your disk.



How to keep track of all instruments sent from the Logic/EXS24 side
Keymap One takes care of tracking all the instruments sent from Logic during 
an editing session, in the new Keymap One Organizer window. Please see the 
Keymap One Organizer section in this addendum for more details.

Things to keep in mind
Unsupported EXS24 synthesis parameters
Keymap One is not a clone of the EXS24, and parts of the EXS24 synthesis 
engine are not available in Keymap One. So while all the unsupported EXS24 
parameters are preserved when you send instruments back and forth, they 
might sound different because of the use of an EXS24 filter, or of an 
unsupported modulation matrix routing.

The No instrument or “---” instrument in Logic is empty
Many times you might want to create new instruments from scratch starting from Keymap One, still using 
the Logic integration. In this case you have to remember that in the EXS24, the default No instrument, 
also shown as  ---, is not an instrument, and so you won’t be able to send it to Keymap One using the 
Open in Keymap One EXS24 menu command to start editing.

No instrument in the EXS24
You should instead create an empty instrument in your sampler instrument folder, and use that as a 
starting point. In that way you can load the empty instrument and send it to Keymap One from the EXS24.
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Drag and Drop support for Zones and Groups from 
the Logic 8 internal EXS24  editor
As an additional integration feature, you can now drag and drop Zones and Groups from the new internal 
EXS24 editor in Logic 8, into Keymap One 1.5.  This is very useful for quickly bringing samples from one 
instrument open in Logic 8 to a project open in Keymap One.

How to drag and drop Zones from the EXS24 internal editor
If you want to drag and drop zones from the EXS24 internal editor to Keymap One, you first have to select 
the zones in the internal EXS24 editor table view, then drag them with the mouse into the matrix of the 
Keymap One Instrument editor. 

If you do not hold any key modifier, the zones will be created in Keymap One at the same exact mapping 
position (low note, high note, velocity range, root note, etc) as in the originating EXS24 instrument. If you 
instead press and hold the option key modifier, the zones will be created sequentially in the Keymap One 
instrument matrix. When you drag zones which have been assigned to a group, Keymap One creates and 
assigns the groups for you, but the groups settings are left at default values. This happens because you 
can’t drag both the zones and the groups at the same time from the EXS24 editor, and so when you drag 
the zones, Keymap One knows that the zones are assigned to groups, but can’t “see” the group settings. If 
you later drag and the drop the groups from the EXS24 editor, Keymap One recognizes that these are the 
groups for the zones you dragged earlier, and instead of creating new groups, will fill the existing groups 
in Keymap One with the proper settings, taken from the dragged groups.



In any case, the zones are always created in new layers,at least one for each group, and you can always 
merge or move zones and layers later using the Keymap One commands and functions. 

Note that the zones and groups you create in Keymap One in this way are distinct and independent from 
the zones and groups in the EXS24 editor, i.e. editing a group in Keymap One will not change it in the 
EXS24 editor directly.

How to drag and drop Groups from the EXS24 internal editor
If you want to drag and drop groups from the EXS24 internal editor to Keymap One, you first have to 
select the groups in the internal EXS24 editor table view, then drag them with the mouse into the Keymap 
One Instrument Editor Matrix. If there are no existing groups with the same name, Keymap One will add 
the  groups   to the instrument. In the case that groups with the same names already exist in the 
instrument, then Keymap One will simply replace the parameters in those groups, without creating 
duplicates. 

Not all Group settings are transferred using  drag and drop
As of Logic version 8.0.0, the internal EXS24 editor does not export all data for its groups when you use 
drag and drop. The Select Group By settings , in particular, are not transferred, and you might have to set 
them manually in Keymap One if you want to replicate the groups exactly.

A useful trick: how to drag and drop audio regions from the Logic 
arrange window to Keymap One

As of Logic version 8.0.0, you can’t directly drag and drop audio regions from the Logic arrange window to 
Keymap One. Using the drag and drop feature from the EXS24 internal editor, and the fact that you can 
drag from arrange to the EXS24 internal editor, you can however do it anyway. As first thing, you should 
create an empty EXS24 instrument, that you will use as a “scratchpad” for the audio regions. Every time 
you want to drag and drop an arrange audio region to Keymap One, you first should drag and drop it to 
the internal EXS24 editor, and then drag and drop it from the internal EXS24 editor into Keymap One. In 
this process, no new audio files will be created, and Keymap One will reference the same audio file as 
Logic, so you should be careful not to delete, replace or  modify it from Logic 8 or you will change the 
audio data in Keymap One too. There is no problem in editing in Keymap One, as all the edits are 
completely non-destructive, and the audio data is never changed.
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At any time you can create new independent samples from Keymap One by saving the instrument in 
EXS24 format, and forcing the creation of a new set of samples from the save panel. Alternatively, if you 
just want to process the audio region in  Keymap One, and then bring it back to the Logic 8 arrange 
window, you can also export zones by drag and drop to a Finder folder (see later in the manual for how 
this is done), and then drag and drop these new files into Logic 8.

To recap, the first step is to 
drag and drop the audio 
regions from the arrange 
w i n d o w t o t h e i n t e r n a l 
EXS24 editor.

The second step is to drag 
and drop the audio regions 
from the the internal EXS24 
editor to Keymap One .

You can use this drag and drop mechanism both for normal Keymap One projects, and for when you send 
instruments from the EXS24 using the “Open in Keymap One” menu command.

Step 1: drag and drop  the audio region from Arrange to the EXS24 editor

Step 2: drag and drop  the audio region from the EXS24 editor to Keymap
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Virtual MIDI input to Keymap One
Keymap One now offers a virtual MIDI Input which allows you to drive it directly from a sequencer track . 
With this feature it  becomes possible to hear instruments in the context of a song while you edit them. 
This is especially valuable  now that Keymap One can play also when in the background. This new release  
also adds a virtual MIDI Thru connection so that you can now put Keymap One between a MIDI controller 
and Logic. 

Note that this feature has not been designed to make Keymap One a true virtual instrument. 
Keymap One’s performance goal is still “one man playing it live”.  There are many factors that go 
into optimizing an application to be a virtual instrument, which we have not done. For example, 
having two realtime applications running at the same time, can result in scheduling conflicts , 
performance degrade in both the Keymap One and Host applications, and so on .

To avoid possible confusion arising from the new Keymap One MIDI capabilities, the MIDI In 
preference previously available in the preferences window has been renamed to Listen to MIDI 
Device. 

Smart Switches
In order to better integrate with your other Audio/MIDI applications, Keymap One  now offers in its 
preferences panel four automatic switches (Smart Switches) , each  controlling the four main I/O junctures 
of Keymap One: MIDI In, MIDI Thru, Listen to MIDI Device and Audio Out.

Each switch can be independently configured to turn on and off the associated port, depending on the 
active status of the Keymap One application. The Smart Switches can also be configured to be always 
active, or always disabled. In this way you can configure Keymap One to always mute when in 
background, or to listen to MIDI in only in background, etc..



Smart Switches settings
Each switch commands the flow of MIDI or Audio events in specific points, as seen in the following 
diagram: 

Virtual MIDI input, MIDI Thru, and Smart Switches

Keymap

SW1

SW2SW3

Keymap
MIDI In

Keymap
MIDI Thru

"Listen to"
MIDI Device

SW4 Audio outs

MIDI

Audio

MIDI

MIDI

MIDI

MIDI

The switches are set in the Audio/MIDI preferences panel 
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The Smart Switches in the Preferences panel

SW1 SW2

SW4 SW3

Each switch can be individually set at four different settings:

Settings Switch behavior respect to its 
Audio/MIDI Events

Always Disabled The switch never lets its events pass through

Always Enabled The switch always lets its events pass through

E n a b l e d w h e n K e y m a p O n e i s t h e a c t i ve 
application

The switch lets its events pass through only when 
Keymap One is the active application in the 
Finder, i.e. when you are using it.

Enabled when Keymap One is not the active 
application

The switch lets its events pass through only when 
Keymap One is not the active application in the 
Finder, i.e. when you are not using it.



By configuring the Smart Switches, and using all the new MIDI features, you can integrate Keymap One in 
your setup in many different ways. Here we suggest three ways, but there are many other possible 
routings that might be better for your own workflow.
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Example #1: Keymap One between the MIDI Controller and the Host application 
(Logic)
In this first example, Keymap One is placed between the MIDI controller and Logic. We want Keymap One 
not to respond to incoming MIDI events when it’s in the background, as we want Logic to play those 
notes. When Keymap One is active, however, we want  MIDI events to go to Keymap One and not to Logic, 
so that we hear the Keymap One audio out,  and not the audio from the selected instrument track in 
Logic. 
This is how we’d set the Smart Switches:

Smart Switch Setting

MIDI In Always Disabled

MIDI Thru Enabled when Keymap One 
is not active

“Listen to” MIDI Device Enabled when Keymap One 
is active

Audio Out Always Enabled

MIDI Controller

Keymap

Host application
(example: Logic)

"Listen to" MIDI  Device

MIDI Thru

MIDI In

MIDI Out



Example #2: Keymap One after the Host application (Logic)

In this second example, Keymap One is placed after the MIDI controller and Logic. This time, we want 
Keymap One to play the MIDI data sent from a Logic track, but we also want it to automatically stop 
playing the Logic track when it becomes the active Application on the desktop. When this happens, we 
also want it to respond to the MIDI controller directly, avoiding any MIDI processing that might be going 
inside Logic. 
This is how we’d set the Smart Switches:

Smart Switch Setting

MIDI In Enabled when Keymap One 
is not active

MIDI Thru Always Disabled

“Listen to” MIDI Device Enabled when Keymap One 
is active

Audio Out Always Enabled

MIDI Controller

Keymap

Host application
(example: Logic)

"Listen to" MIDI In

MIDI Thru

MIDI In

MIDI Out

MIDI Out

MIDI In
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Example #3: Keymap One in parallel to the Host application (Logic)

In this third example Keymap One is placed in parallel to Logic. We simply want Keymap One to become 
mute when it is not the active application. This is how we’d set the Smart Switches:

Smart Switch Setting

MIDI In Always Disabled

MIDI Thru Always Disabled

“Listen to” MIDI Device Enabled when Keymap One 
is active

Audio Out Enabled when Keymap One 
is active

MIDI Controller

Keymap

Host application
(example: Logic)

"Listen to" MIDI In

MIDI In

MIDI Out



How to configure Logic in order to receive MIDI data from the Keymap One Thru port 
only

In many cases, such as in the previous examples, you will want Logic’s MIDI input to receive events only 
from the Keymap One  MIDI Thru port.  You can do this easily in the Logic Environment window:
1. Select the Clicks and Ports layer,
2. Click-drag the virtual cable connected to the SUM port connected to the Physical input object  to the 

Keymap One Thru port. 

If you keep this cable connected to the default SUM port, you will effectively bypass the Keymap One 
Smart Switches,  and in some cases Logic might receive the same notes twice (one time from the MIDI 
controller, and the second time from the Keymap One Thru port.
 

Configuring the Logic Environment to receive MIDI events from Keymap MIDI Thru only

Page 37



Support for GarageBand and Ultrabeat formats
Keymap One now supports loading and saving instruments in GarageBand and Ultrabeat-sample (.ubs) 
formats.

Garageband format
Each GarageBand instrument is a combination of two files: one .cst (channel strip) file, containing effect 
settings and other parameters, and one .exs file containing the mapping and sample references. Both 
needs to be in their respective GarageBand-supported locations in order for the instrument to be visible 
in the GarageBand instrument browser. Keymap One 1.5 supports the automatic creation of the .cst files 

when you save to exs format in GarageBand format.

When saving to Garageband format, Keymap One will 
switch automatically the save panel to the proper 
GarageBand folder, and will force you to remain there. 

Once you set the name to be used, and click on the 
“Save” button, Keymap One will create both the .cst 
and the .exs files, and will also add a new Keymap One 
instrument category to GarageBand. 

Additionally, it will set the .cst file permissions to “read only” to protect it from undesired changes. 

The very first time you save in GarageBand format on your Mac, you will be asked to authenticate yourself 
and enter your password, as Keymap One needs to access a few protected files to add the new Keymap 
One category. Note that Keymap One does not support the specific GB features as the effects and the EQ, 
and does not read or use the .cst files directly.

You might also need to restart GarageBand for the new instrument to be properly recognized.



Ultrabeat format (.ubs)

The Ultrabeat sample format (.ubs file extension) is used for adding custom samples to each of the 
Ultrabeat voices in Logic Pro.

Each .ubs file contains both the mapping definition and the audio data. In other words, .ubs files do 
not reference external audio files.

Ultrabeat expects each .ubs file to contain a single note mapping, and you can have multiple 
velocities. This means that the .ubs file might look a bit odd, mostly empty, when opened in 
Keymap One.

The actual note mapping isn’t relevant, as Ultrabeat loads each .ubs file to a single (note) slot 
anyway.

When you open an Ultrabeat file, Keymap One will temporarily create sample files on disk containing the 
embedded  audio data, and the zones will reference those sample files. This lets you open a file in the 
Ultrabeat format, and save it in another format at will.
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Support for the EXS24-Monolithic format

The EXS24-Monolithic file format is an hybrid of the EXS24 and the Ultrabeat formats. Each 
monolithic .exs file contains all audio data in the instrument file itself. This means that you can now save a 
whole instrument as a single monolithic .exs file, and that loading in RAM will be very efficient. 

There are a few limitations to be considered in the use of this file format: 

• When loading instruments in this forma,t the virtual EXS24 memory settings will be ignored, and the 
samples will be loaded entirely in RAM.

• A second important limitation is that the EXS24 will strip out the embedded audio data if you edit and 
save any kind of changes to instruments in this format. After this happens, the EXS24 instrument will 
become “normal”, in that it will try to access the original sample files the next time you load it.

•  A third limitation is that you can’t view or edit the embedded samples from within Logic. Unless you 
have the sample files on disk, the sample files used by the EXS24 instrument will appear as missing.

• A fourth limitation is that this format uses advanced features of the EXS24 engine, and might not be 
readable by other samplers with standard EXS24-import capabilities.

To help protect against the accidental editing of the instrument, the permissions for the EXS24-Monolithic 
files created by Keymap One are set to read-only. 

When you open an EXS24-Monolithic instrument file, Keymap One will temporarily create sample files on 
disk containing the embedded  audio data, and the zones will reference those sample files. This lets you 
open a file in the monolithic format format, and save it in another format at will.



Keymap One Organizer
The Keymap One Organizer is a new window that shows you the currently open projects (instruments) in 
Keymap One.  You can switch to a specific project by double clicking its name in the table. When the 
Keymap One MIDI In port is used to play Keymap One from a sequencer, or when Keymap One is not 
active, the Organizer also selects the currently playing project. 

In addition, when a project originates from Logic via the Logic 8 integration feature,  it is marked in the 
Organizer as (from Logic), and you can select it and send it back using the Send back to Logic menu 
command or the ➡EXS24  button available from the panel. 
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Drag and drop sample export from Keymap One
You can now drag and drop edited samples from the instrument editor or the resources window to the 
finder. When using this feature, Keymap One always creates new samples at the drag and drop 
destination, and existing files will never be overwritten.

You can easily use Keymap One as a scratchpad via this feature by editing/remixing loops and musical 
phrases, and then exporting them as normal audio files to be used in Logic’s arrange window.

Mapping and loop data in the exported sample files
All new samples created via drag and drop have their fades parameters rendered. They also contain the 
mapping and loop data from their original zones. This makes using these samples in other applications 
very straightforward. The exported samples are always rendered as standard 24 bit AIFF files, named after 
the original zones.



Dragging to other applications
Not all applications support this kind of inter-application drag and drop. As of version 8.0.0 , Logic doesn’t 
support it, and Keymap One itself only supports it as a source, not as a destination.

A useful trick: how to drag and drop processed samples from Keymap 
One to Logic 8
Even if Logic 8 doesn’t support direct drag and drop from Keymap One, you can use a Finder folder as 
intermediate destination to achieve the same result: first drag and drop export the zones to the Finder 
folder, then drag and drop into the Logic arrange window, and...  that’s it.

Exporting samples by drag and drop doesn’t affect the Keymap One 
instrument
The instrument in Keymap One from which you dragged the zones to the finder is not affected by the use 
of this feature, and will keep referencing the original samples. 

How to  drag and drop from the Instrument Editor
If you want to drag and drop samples from the instrument editor, just select one or more zones in the 
current layer, hold down the alt+shift modifiers and drag them to the finder: the new sample files will be 
created there.

How to drag and drop from the Resources Window
To drag and drop samples from the resources window, select one or more zones in the zone table and 
drag the zones horizontally to the Finder: the new sample files will be created there. 
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Tuning Fork
Keymap One now offers a pure sine wave tone generator that gives you both acoustic and visual feedback 
for your tuning settings. The Tuning Fork is accessible via the Utilities>Tuning Fork menu command.

The parameters are quite straightforward.

Extended contextual menus
All the contextual menus have been revised and expanded, with all of the most important commands 
now available at your right-mouse-click fingertip.



Extended Resources Window 
with integrated Sample and Loop editors
The resources window now  offers fully resizable and collapsable integrated sample and loop editors, so 
that you can perform many tasks staying in one single window. The sample editor is identical to the fully 
featured version in the Instrument editor.
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“In context” sample replace 
When you replace a sample, you can keep playing the instrument from MIDI and preview the selected 
sample from the open panel directly in the context of  the instrument (with volume, pan, tuning, looping, 
etc) before actually replacing it.



Remap by note and velocity
The new Zones>Remap>Remap by note and velocity command lets you remap multiple zones over 
notes and velocity, in a single operation.

New group creation commands
Three new group creation commands lets you create and assign new group to zones. 

The Zones>Assign to new group menu command creates a single group, and assigns it to the selected 
zones.

The Zones>Assign each zone to a new individual group menu command creates a new individual group 
for each zone and assigns it to that zone. This is especially useful if you want to create a separate 
amplitude envelope for each zone, which in  the EXS24 you can do through the use of group offsets 
(graphically visualized and edited in Keymap One).

The Layers>Assign whole layer to a new group creates a new group , and assigns it to all the zones in the 
current layer, whether they are selected or not.

Key Commands reorganization
The key commands have been reorganized and streamlined. Key commands now exist for all functions. 
The key commands are now also global, so that you can, for example, use zone key commands while 
editing a sample.  All menus, including the contextual menus, display each command’s key equivalent.. 
The Key Command Manager has been improved to help show which keys are used.

Increment/decrement  loop end commands
Two new menu commands let you add or subtract one sample from the end of a loop, which helps you fix 
instruments converted from other formats. The commands are accessible as Zones>Loop>Increment 
loop end by 1 sample and Zones>Loop>Decrement loop end by 1 sample.
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Additional functions for the Magic Pad 
The Magic Pad now has three additional functions.

NEW FUNCTION #1: When holding the shift key modifier while dropping samples, the sample search will 
take place within regions and then split. No autolooping is done, since you can always autoloop individual 
zones later. Keymap One creates a new layer for each single file and places sequentially all regions from 
that file in that layer. You can later merge layers by selecting one and using repeatedly the merge key 
command (default: “m”)

NEW FUNCTION #2: When holding the shift+control key modifier while dropping the samples, the 
samples will *not* be split, but will be mapped onto a single note over the velocity range, using velocity 
detection. A panel asks you to which note to map the sample.

NEW FUNCTION #3: When holding the option key modifier while dropping the samples, the samples will 
be automapped based on the root note in the sample names (example: FLUTE-C#3-33.aif ). The samples 
will also be sorted over the velocity axis by ascending name. In many situations this allows instant 
creation of instruments out of samples.

Another new feature in Keymap One 
1.5 is that the Magic Pad now shows 
the list of the functions available. The 
list is displayed in a pop-up panel 
w h i c h a p p e a r s w h e n y o u d r a g 
samples over the pads.



Drag and drop support to single note, multiple 
velocities
Similarly to what is now available for  the Magic Pad, you can now drag and drop multiple samples to a 
single note by holding the control key modifier while dropping samples in the matrix. The samples are 
placed sequentially from bottom to top in alphabetical order to that single note. You can later re-sort 

them us ing the a u to m a p ve l o c i t y 
func t ions, or the new swap along 
velocity key commands.

When dragging samples to the matrix, a 
new help message also shows you the 
list of possible key modifiers you can use 
to tweak the way new zones are created 
when you drop the samples.

Once you are familiar with the possible 
key modifiers, you can disable this help 
feature by unchecking the “Show Drag 
And Drop Help” checkbox in the Keymap 
One Preferences.
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New zone “swap along velocity” commands
Two new commands let you swap adjacent zones along the velocity axis within the instrument matrix, 
making it very easy to sort samples by velocity.  The commands for this are Zones>Remap>Swap 
zone with zone at the top and Zones>Remap>Swap zone with zone at the bottom.

SD2 Read support 
Keymap One now reads the SD2 sample format. The format support is however read-only, and is not 
offered as a choice when new samples need to be rendered.

Zoom freeze
In the sample editors you can now freeze the horizontal zoom and the visualized sample area relative to 
sample start. This lets you easily inspect the same portion of a sample across multiple samples. This 
function is ideal for close inspection of sample attacks. The function is activated by pressing the  “Zoom 
Freeze” button found next the sample editors.

Parameter Sliders reset
Sliders, and their associate parameters, can now be reset to their default value by holding the alt key 
modifier while double clicking on it.

Extended support for root notes in sample names
The support for analyzing and reading root note names embedded in sample names has been extended 
and should now cover all the known naming conventions. It is now also possible to force the analysis to 
skip a user-defined number of characters from the sample name beginning. 



New close project command
The new File>Close current project menu command  lets you close the whole project at once.

Tooltips disable
A new preference checkbox lets you disable tool tips in Keymap One. The tool tips always remain enabled 
for menu items, however.

Default extra space when creating regions
When cutting sample regions, you can now set a default extra “space” (in other words, section of silent 
audio) to be added automatically to the beginning and to the end of the region, so you have some room 
to tweak your samples (attack, etc) after the split. You can separately set these “PreStart” and “PostEnd” 
lengths from the preferences panel.

Drag and drop zone copy in matrix
You can now copy zones simply by dragging them into the instrument matrix while holding the option 
key modifier.  If you drag the zones to the layer table, you can also switch the current layer, so that it 
becomes possible to copy across layers using drag and drop.
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Automatic playback restart when browsing zones 
and regions
When you browse zones or sample regions with playback active, Keymap One now automatically restarts 
playback from the beginning, so that listening to the samples now simply requires that you press the 
cursor keys.

 

Sort zones by name
Two new commands let you sort zones (over the velocity or over the note ranges) by name in both 
ascending or descending order, so that if you want to remap zones in the matrix, you can assign the 
proper names/numbers and use the new sort commands. The commands are  Zones>Remap>Sort by 
ascending name and Zone>Remap>Sort by descending name.

Reset sample start/end command
The convenient Samples>Set start and end to full sample menu command lets you set the start and the 
end of your zone to the start/end of the sample.

Improved editing of samples with blended cuts
When cutting/deleting/pasting samples in the sample editor, Keymap One can automatically set a desired 
crossfade length and shape in order to smooth the edit. You can see the crossfade by enabling the slice 
view in the Sample Editor.

A new Blend menu command lets you add or change the crossfade to a split.  You can assign the 
crossfade an arbitrary length and select between  multiple shapes.
You can blend an edit anytime using the mouse, by holding the option+command key modifiers and 
selecting the blend area across the split. As soon as you release the mouse button, the new blend will be 
performed. As with everything in Keymap One, the blend operation is completely non-destructive and 
performed in realtime.



Blend

New sample Slice cursors
The full Sample Editor now shows 3 new cursors for each slice, allowing you to move the slice point and 
shift the slice content. The new cursors become visible when the “Slices” view mode is enabled in the 
Sample Editor window, and the editors is displaying a slice point.

The central cursor moves the slice point without 
changing the overall sample length. The other two 
cursors at left and right instead shift the content 
inside each slice, allowing you to align or tweak 
transients at will. All these operations are non-
destructive.
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Extended selection modes from MIDI/Virtual 
keyboard
Keymap One now has three distinct selection modes available in the instrument editors, which let you set 
how Keymap One reacts to incoming notes from your active MIDI Ports or from the Virtual Keyboard. The 
three modes are selected through a new button control shown at the top of the instrument editors.

• No selection from MIDI
In this mode, the incoming MIDI notes will be ignored, unless you press and 
hold the control key modifier while playing. In that case, the triggered zone in 
the current layer will be selected.

• Select one zone from MIDI
In this mode, the incoming MIDI notes will select the most recently triggered 
zone (one single zone). If there are multiple zones playing at the same time in 
different layers, sending the same note repeatedly will change the currently 
selected layer in order to cycle through all layers with a playing zone. If you 

press and hold the control key modifier while playing in this mode, the triggered 
zone in the current layer will still be selected, but the layer selection won’t change.

• Toggle zone selection from MIDI
In this mode, the incoming MIDI notes will toggle the selection status for the 
newly triggered zone(s). 



Group assign in resources window
It is now possible to assign a group to zones directly from the resources window, through a group pop-up 
menu selector. Note that as groups belong to (Keymap One) Instruments, you will be able to assign 
groups only if all the selected zones are from the same instrument.

Grey out already used samples in open panels
When adding/replacing/searching samples it is now possible to gray out samples already used in your 
current project by enabling the new Gray out already used samples checkbox in the open panel for 
samples.

MIDI Input preprocessing
A new preference setting lets you preprocess incoming MIDI notes so that you can replace the velocity 
value with the current value of a MIDI controller. 

At all effects, when this feature is enabled, Keymap One will use the value from the controller, instead of 
the note velocity. This preprocessing mode can be toggled in preferences, from the Edit>Toggle taking 
velocity from MIDI Ctrl menu. It is also available as a key command. You can use this command to check 
the velocity transitions for zones precisely, as you can assign a slider/knob/pedal to velocity, play your 
MIDI keyboard, and hit/select exactly the desired velocity. Note that this new functionality is completely 
different than setting the Vel mapped as parameter which enables dynamic crossfading and only changes 
the source of velocity data for the synthesis/crossfade engine.
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MIDI Controllers learn
All pop-up menus which let you select a MIDI controller now have a MIDI Controller learn feature, 
accessible by clicking their associate  “M” button.

MIDI Controller Learn

Instrument and layer name visualization in matrix
The currently selected layer is now displayed in the matrix. Similarly , the currently selected instrument is 
displayed in the setup matrix, together with any transpose or velocity offset you might have set.

Instrument and Layer names in matrix



Improved sequential mapping in matrix
When sequentially mapping samples in the instrument matrix you are now asked to enter a starting note, 
and the desired note range width for the created notes.

Sequential mapping panel

Group range visualization in matrix
It is now possible to visualize graphically the range of groups superimposed over the zones inside the 
instrument matrix. This offers you a clear view of the zones/groups relationships. The group ranges are 
displayed in yellow, and can be enabled or disabled by using the View>Show>Groups menu switch.

Group visualization in matrix
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Note that the groups are only displayed as yellow frames in the matrix if they do not cover the full matrix 
range (i.e. when it's not 0-127 for notes and  0-127 for velocity). This visualization is very useful when you 
edit in the the group fade editor to see the matrix area being touched by the group. When this feature is 
enabled, and groups are selected, the zones linked to those groups are highlighted too.  

Dynamic crossfade controller visualization in 
matrix
The new View>Show>Dynamic crossfade ctrl value menu switch enables the visualization of the current 
controller value used for dynamic crossfades in the matrix as an horizontal line across the instrument 
matrix. This visualization is intended only for continuous controllers, and not for note velocities, for which 
you already have the red dots.

Dynamically switchable editor layouts
It is now possible to switch across the various layouts (Compact, Normal) for the instrument and setup 
editors at any time by using the new “CN” layout selector.

Layout selector
Compact Normal



Optional selection link between instrument editor 
and resources window
It is now possible, as an option, to synchronize the selection between the instrument editor and the 
resources window, so that it’s easier to use windows in an editing session. The feature is enabled by the 
Link checkbox available in both the instrument editors and the resources window.

Linked (synched) selections

Instrument editor Resources Window

Region selection key commands
The two new Regions>Select next region and Regions>Select previous region menu commands (and 
key commands) let you select the next or previous sample region.

Improved layer support in the EXS format
The support of Keymap One layers in the EXS24 format has been improved. When you save a project in 
EXS format, the layer to which each zone belongs is now embedded in the zone name as a 
special”<KmL...>” suffix. When Keymap One loads an EXS instrument, these special suffixes are 
recognized, used for proper Layer positioning, and then stripped away from the names, so that they never 
appear in the Keymap One editors.

Increment/Decrement controls for all parameters
You can now increment/decrement values in all parameter boxes by selecting the value and using the up/
down cursor keys. You can also modify values using a mouse by selecting a parameter, holding down the 
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option key modifier and dragging the mouse to set the desired value. Double-clicking while holding the 
option key resets the parameter to its default value.  If you press and hold the option key modifier while 
pressing the up and down cursor keys, you will set the parameter value respectively at the maximum and 
the minimum possible values.

Zone toggle loop function
The new Zones>Loop>Toggle loop menu command lets you enable/disable the loop for multiple zones.

Redesigned layout functionality
The various editor windows sizes, their positions, the zoom level and other editor parameters are now 
saved globally, instead of per project. This means that once you find a comfortable layout on your screen, 
all projects will subsequently open with that layout.

QsPerc renamed to Smoothing
The Quadrasmooth QsPerc parameter has been renamed Smoothing.

New “Set … to cursor” commands in sample editor
New commands let you set various sample parameters (start, end, loop start, end, etc), to the current 
sample cursor position. The new commands are accessible at the Samples>Cursor submenu.

New Select all zones in current note range 
command 
The new Zones>Select>Select all zones in current note range menu command lets you select all zones 
which share at least one note over the note range of the current selected zones. This is useful if you want 
to select a whole “column” of zones. Just select one of the zones, use this new command, and all the 
velocity zones  above and below  the current zone  will be selected.



Pivot remapping functions
The new Zones>Remap>Pivot on corner menu commands let you remap the selected zone over the 
note and velocity axis so that a multiple note mapping becomes a multi velocity mapping and vice versa. 
The pivot remapping will also change the root notes for the zones involved.

The operation can be performed for whole layers using the new Layers>Pivot menu command.

Remap Pivot on corner

Remap Pivot on corner

Layer Pivot

Layer Pivot
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Search for missing samples command
You can now search for missing samples in your projects at any time, not just at load time. This gives you 
the opportunity to update your LiveDB sample search paths and search again for samples in the new 
search paths without having to reload the instrument. This capability is accessed by selecting zones in the 
Resources Window and using the new Search again missing samples contextual menu command.

Reorganized preferences panel with default values
The preferences panel has been expanded and reorganized so that you can now set the default values for 
some parameters used in the various Keymap One functions.

New intersect all groups to all zones command
You can now intersect all zone ranges (notes, velocity) with their groups in order to streamline your 
projects. This can help you get much better zones/layer layouts when you work with instruments 
converted from other formats in which the zones take the whole velocity range, and the group limit that 
range to a very small section.



Relink to Renamed Samples (RRS)
The LiveDB sample search engine in Keymap One can now search and relink samples that have been 
renamed manually in the finder, or by using 3rd party utilities. 

SAMPLE REQUIREMENTS
The RRS feature comes into effect when you first open an instrument or document if a sample can't be 
found at its original location with its original name. This feature is restricted to sample files stored in one 
of the LiveDB Search Engine paths found in the preferences panel. If the renamed samples are outside of 
those paths, this new RRS search  will not be used to relink them. This restriction is useful because it gives 
you the opportunity to be in control of the process, and lets you take samples out of a folder in order to 
ensure they won’t be searched for in their new location.

The LiveDB paths can be changed and restored at anytime, and they affect the places where Keymap One 
will search when you openan instrument or document.  These paths do not affect anything when saving a 
document or instrument.

For example, you can have no LiveDB path set, save the instrument, quit Keymap One, rename the 
samples using the Finder, start Keymap One, set the LiveDB path to that sample folder, and reopen the 
instrument succesfully.

The sample files can be renamed in any way or moved across subfolders (the folder names are irrelevant 
too), as long as they stay in one of the LiveDB paths, do not cross volumes, and aren't modified/edited in 
any way. Also, as of version 1.5, the feature supports HFS+ filesystems only (no network mounts, FAT, 
NTFS, ZFS, etc).

INSTRUMENT REQUIREMENTS
The RRS feature is enabled only for KMP format projects that have been saved at least once with Keymap 
One version 1.5, and with all sample references correct. 

OTHER THINGS
The KMP project must not be open in Keymap One when you rename its samples externally. The RRS 
search happens only when you open a document or instrument and when you use the Search for 
missing samples again command in the resources window. If you rename a sample externally (example 
with the finder) while its kmp project is open, Keymap One will not recognize this in realtime.
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ANOTHER EXAMPLE OF HOW THE RRS FEATURE WORKS:
Example: you have 4 KMP drum projects, sharing the same drum samples.

1. Open each of the KMP projects with Keymap One version 1.5
2. Check that all samples are found
3. Save each project back to disk again
4. Quit Keymap One
5. Now navigate to the samples and rename them/create subfolders/move them, etc. (but do not  move 

samples across different volumes, or create duplicates and delete originals).
6. Restart Keymap One, make sure that the samples are in one of the LiveDB paths.
7. Open the four instruments, and they will find and use the renamed samples.

If at this point you save the instruments again (which we recommend)  Keymap One writes the renamed 
sample paths directly into the KMP project so that next time you open the project, the samples will be 
found directly without going through the RRS mechanism.


